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1. General 

 

The combined Remote Terminal Annunciator TELEM-RTA-A is a master remote 
terminal unit for coordinated substation control. TELEM-RTA provides control 
operations, data collection, protocol cross-referencing and data exchange with the 
remote control center. At the same time it announces events on the front panel. If 
required, the units can be cascaded to obtain the desired capacity of the system. 
The TELEM RTA-A device is similar to the data concentrator TELEM GW6 with the 
same configuration software and main possibilities. It has a reduced quantity of 
communication ports but it has additional data collection and event indication 
possibilities. 
 

2. Possible Applications 

 

Data acquisition and control of regional and national electricity utilities in SCADA 
systems. In other supply networks also of regional public utilities (gas, water, 
sewage, district heating, power plants). 
 

3. Features 

• Analog signal measurements 

• Digital contact and acquisition of pulse counting info  

• On/Off control functions 

• Concentrated data acquisition and control using different communication 
protocols (see 5. Technical Data) 

• Protocol cross-referencing 

• Logical operations between digital and analog signals can be described 

• Local or remote programmable configuration 

• Local event reporting and acknowledgment 

• Duplex data communications between the feeder and the equipment level versus 
the station control level in substations using different communication protocols 
and cross-referencing between the protocols 

• Full scale data exchange between the levels of the substation control system 
including setting values, measurement values, registered fault parameter values, 
changes of state with associated time markings etc 

• Telem-RTA-A is provided with serial interfaces to facilitate the connection 
between local output devices and external host systems 

• All the settings can be changed using software configuration tool via serial or 
ethernet port 

• Output channel to the remote control system can be connected to a leased or a 
dial-up line using a copper line-, radio- or GSM modem 

• Telem RTA-A is provided with control input for clock synchronizing purposes 
using GPS 
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• RTA-A time synchronization by communication protocol (IEC 6870-5-101, IEC 
6870-5-104) from control center’s channels (time synchronization is possible from 
multiple control centers) 

• Time synchronization of substation devices by communication protocol (IEC 
6870-5-101, IEC 6870-5-103) 

• Time synchronization by SNTP protocol (on Ethernet connection) 

• Logical operations between digital and analog signals can be described 

• TELEM RTU devices can be remotely configured across Telem-RTA-A 

• Configuration export to ASCII, CSV format files 

• A user-friendly user interface similar to MS 

• Collects and transfers the sequence of events (SOE) with 1 ms accuracy 

• Data sending with time and quality stamp 
 

4. View 
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5. Technical Data 

• Number of differential analog inputs  6 

• Analog input range (hardware specified) 0… 5 mA; -5…+5 mA;  

0…20 mA; -20…+20mA 

• Number of analog outputs   2 (optional) 

• Analog output range    0…20 mA, 30 V max 

• Number of isolated digital inputs  18 (16 dry contacts with an internal 
       supply, 2  with an external supply) 

• Number of ON/OFF operations  5 (1x2 open collector and 
4x2 open drain outputs), 30 V max, 
0,1A max 

• Number of event indicators LED  16 

• Number of acknowledge buttons  16 

• Number of RS 232 communication ports 4 

• Ethernet port      1 

• SSP port for TELEM DO/DI device   optional by request 

• Dimensions (WxHxD):    145x145x93 mm (without screw 
      terminals) 

• Mounting      onto panel or DIN35 rail 

• Weight      0,6 kg 

• Dimensions of panel cut-out   138x138 
 

Data communication protocols 

• To higher level systems IEC 60870-5-101 Unbalanced and Balanced, 
IEC 60870-5-104 

• To lower level devices IEC 60870-5-101 Unbalanced, IEC 60870-5-103, 
IEC 60870-5-104, SPA-bus, IEC 62056-21 (IEC 1107), Modbus-RTU, 
Modbus-TCP 

 
Data communication parameters 

• Start bits      1  

• Parity      odd, even or no parity  

• Communication rates    from 300 to 38400 bit/sec   
       asynchronous 

• Communication modes    RTS/CTS Control, No Control 
 



AS Martem                                  TELEM-RTA-A  User Manual  Rev. 11 / 2012 

 

 

 

Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.ee 

12618 Tallinn                                  Fax: +372 639 79 80                                                 www.martem.ee 

Estonia 

6 

Power supply: 

• Supply voltage     24 V DC 

• Supply voltage for dry contact input 48 V DC 

• Power consumption    < 5 VA  
 
EMC 

• Emission     EN-55022 

• Immunity 

•   Static discharge    EN-61000-4-2 

•   Conducted HF field   EN-61000-4-6 

•   RF field     EN-61000-4-3 
 

• Power and signal inputs 

•   Dielectric withstand    IEC 60255-5 

•   Fast transients    EN-61000-4-4 

•   Surge     EN-61000-4-5 
 

6. Switches  

• 1 – not in use 

• 2 – not in use 

• 3 – ON – force COM1: Addr.1, /9600/8 NI 

• 4 – ON – restore default setup* 

• 5 – OFF – oper mode, ON – Firmware update mode  

• 6 – ON - Reset 
 

* To restore the default setup, follow this sequence: 
     Sw 4 ON -> Reset -> Sw 4 OFF within 5 sec. 

 

7. Ports 

• COM 1 – RS-232 (Communication or Firmware update) + 
GPS time synchronization 

• COM 2 – RS-232 with all modem signals 

• COM 3,4 – RS-232 interface 

• COM  5  – Ethernet (Communication and/or Firmware update) 

• SSP – for connecting the TELEM DO/DI device and LED indication panel 
(optional) 

• EXT – for connecting an external expansion device 
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COM port’s pin layout 
Pin 1 2 3 4 5 6 7 8 

 -  - GND RX TX GND - RD* 

COM 2 DSR CTS GND RX TX DCD RTS DTR 

COM 3,4 - CTS GND RX TX GND RTS - 

* Time synchronization using GPS 
 

8. Indication 

 

For operation 

• Green LED – Blinking indicates operating mode 

• Red LED – Failure 
For communication 

• Yellow LED – RX 

• Green LED – TX 
 
Green LED at SSP port - blinking indicates GPS time synchronization 
 

9. Terminal Blocks 
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10. Events Archiving 

 
10.1 Events log 
 
Sequence of events (SOE) are collected with 1 ms time resolution. These events are 
archived in the form of text files in folder ftp://<ip address>/events and are physically 
saved to device’s flash memory. Events log will be updated only if any events occur. 
If no events are detected, nothing will be written to events text file. 
 
Last events reside in file Events.txt, which can grow up to 500 kB in size (about 10 
000 events). On growing over this limit the Events.txt is renamed to Events.NNN, 
where the NNN is file no. and the new Events.txt starts to grow from zero again. 
Events.NNN is also copied to Events.bak , previous Events.bak is overwritten. 
The contents of Events.txt and Events.bak is viewable in Web Browser. 
 
Events.NNN files are stored in compressed form in  Events.bz2, which can grow up 
to 4 MB, after that the older files inside Events.bz2  will be deleted. 
All these files can be retrieved over FTP connection. 
 
Archive includes: 

- Events.txt 
- Events.bak 

 
- Compressed container Events.bz2: 

 
 
 

10.2 Error log 
 

All detected errors are archived in text files in folder ftp://<ip address>/errors and are 
physically saved to device’s flash memory. 
Last errors reside in file Errors.txt, which can grow up to 500 kB in size (about 10 000 
errors). On growing over this limit the Errors.txt is renamed to Errors.NNN, where the 
NNN is file no. and the new Errors.txt starts to grow from zero again. 
 
All these files can be retrieved over FTP connection. 
 

Events.001 
. 
. 
. 
Events.NNN 
 

Viewable in Web Browser 
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11. Digital Input Processing 

 

Digital input signals are applied to two filters, at first to “Debouncing” and then to 
“Chatter” filter. 

 
11.1 Debouncing Filter 
 

The digital debouncing filter prevents switching noises. 
Configuring parameters: 
Tolerant phase - a period of time during which contact bounce is “acceptable”. 
Having a tolerant period allows you to monitor and time-stamp the initial state of 
change while ignoring any subsequent contact bounces.  
Intolerant phase - a period of time following the tolerant phase during which contact 
bounce is not “acceptable”. It ensures that contact bounce is not mistaken for a valid 
change of state. 
 
 

Intolerant phase

Intolerant phase

Intolerant phase

Signal

Contact bounce No bounces

Tolerant phase 

Intolerant phase

Time-stamp of state

         change

State shange 

  recognase

Signal after

   filtering
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11.2 Chatter Filter 
 
Chatter Filter detects input chatter preventing filling buffers. 
Configuring parameters: 
Chatter times (changes) - maximum allowed number of state transitions that can 
occur within a filter base period. If the number of state transitions during the filter 
period equals or exceeds the maximum allowed number of state transitions, chatter 
filter will turn ON and any further transitions will be ignored for the duration of the 
“lock-out” period. 
Lock-out period - minimum number of filter base periods during which the chatter 
filter will remain ON. The chatter filter can proceed from ON to OFF only if no state 
transitions are detected during the entire lock-out period. 
Example: Chatter times (changes) 5, Lock-out period 1 
 
 

Signal

1       2      3       4         5

Filter State                                        ON                                                              OFF

Signal after

chatter filter

Base period

Configuration: Changes - 5, Lock-out period -1 (1x Base period)

Lock-out period

Lock-out period

Lock-out period

Lock-out period

No. of changes

Signal changing No changes

Time-stamp of state

         change

State shange 

  recognase
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12. TELEM RTA-A Configuration Tool 

 
12.1 Getting Started 
 
Configuration program works on Windows operating systems. When starting the 
RTA-A configuration program, user interface window with the main menu is opened: 
 

 
 

Figure 11.1.1 User interface window 
 
The following parameters are shown for information:  

• Port – PC port which is used to communicate with RTA-A 

• Link address – Link address of RTA-A 

• ASDU address – ASDU address of RTA-A 

• Status – Status of the connection. RED – no connection, GREEN – connection 
OK 

 
Device menu 

• Device – For selecting the device type 

• Communication Setup - For changing serial communication parameters to 
connect with RTA-A.  

 

 
 
Figure 12.1.2 Communication parameters window 
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Fields in the communication parameters window 

• Port – PC communication port which is used to communicate with RTA-A 

• Baud rate – Data communication rate 

• Parity – Use of parity control bit  

• Flow control – Determines whether the RTS/CTS handshaking is used  

• Communication delay – Delay between reception of data and the next query in 
milliseconds  

• Link address – Link address of RTA-A 

• ASDU address – ASDUI address of RTA-A 

• ASDU address length – The length of the ASDU address in bytes: typically 2, 
possible values are 1 or 2. 

• Object address length – Length in bytes. Typically 2, possible values are 1, 2 or 
3.  

 
 
12.2 RTA-A Configuration Window 
  
To open the RTA-A configuration window, select Device > RTA-A from the user 
interface main menu. 
 
Shortcut icons below the menu bar: 
 

 Open a new configuration 

 Open a configuration file 

 Save the configuration to a file 

 Read the configuration from RTA-A 

 Write the configuration to RTA-A 

 Reset RTA-A* 

 Load XML file (IEC 61850) ** 

 Reload all XML files attached to devices (IEC 61850) ** 

 Read the configuration from RTA-A over SSH connection*** 

 Write the configuration to RTA-A over SSH connection*** 

 Cancel SSH connection*** 

 
SSH connection setup – enter correct IP address and password 
of device*** 

 Firmware update over SSH connection*** 

 
 * Possible Reset codes: 
 1 – Simple Reset 
 2 – Reset that also clears memory buffers 
 3 – Reset that also restores the default setup 
 ** IEC 61850 currently available only to Telem-GW6 

*** Requires 3-rd party software “PuTTY” 
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Saving, editing and opening configuration data 
Configuration data is saved to the hard disk in the form of comma separated 
files*.CSV files when the Save or Save As command is chosen from the File menu. 
Correspondingly, the Open command from the File menu opens this type of file. 
Open and Save can also be accessed via shortcut icons. 
*.CSV files can be conveniently edited with Excel software or even with the Note Pad 
program. When editing the configuration with Excel, the file has to be saved as a 
comma separated CSV file.  
 
Table of configuration window menu items 
 

Main menu File Common Help 

Submenu 
(Shortcut key) 

New  (Ctrl+N) 
Read 
Configuration 

Help  (F1) 

Open(Ctrl+O) 
Write 
Configuration 

About 

Save (Ctrl+S) 
Cancel Active 
Transfer 

 

Save As Send Reset 

Exit 
Analog 
Groups 

 

Tcp/Ip 
Settings 
Timing 
Settings 
Modem 
Settings 

Port Mirroring 

Options 

 
 
 
12.3 Tab Cards in the Configuration Window 
 
Configuration and setting parameters can be utilized by using topic tab cards:  
Ports, Devices, Objects, Formulas, Status. 
A click on a tab card button switches between tab cards.  
 
Using the grid area 
Parameters can be selected or changed in the grid area cells. Values of some cells 
can be changed directly and those of others via a list box or a popup window. 
 
Values of the same column can be copied to clipboard. Use a left mouse click 
together with the Shift key to copy and a left mouse click together with the Ctrl key for 
paste operation. 
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Status message in the bottom left corner of the window shows the result of the last 
data modification action (OK, Error, etc). 
 
 
12.3.1 Ports Tab Card  
 
Ports/configuration tab card is active when the RTA-A configuration window is 
opened. 
 

 
 

 

Configuration parameters of a port: 

• Protocol – Communication protocol used by all the devices of this port. Each 
protocol name is accompanied with a symbol ”^” or ”ν” which indicates whether 
the port is used for an uplink or a downlink channel. For example, “Modbus ν” 
means that this port is used for downlink with Modbus protocol. 

• Baud rate – Data communication rate  

• Parity – Use of parity bit for all the devices on this channel 

• Stop Bit – possible values are 1, 2 

• Data Bits – possible values are 7, 8 

• Communication Mode – Makes it possible to choose between the following 
handshaking options: 
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 - No control 
 - Modem Callout – Port 2 
 - RTS/CTS  Control – Port 2 
 - RS-422/485 – Port 5 – not in use 
 - Tcp/Ip  

• IP address – communication IP address (used if Communication Mode is set to 
Tcp/IP) 

 
IP Address – an address of the device which 
can connect with RTA-A using corresponding 
port (if set to 0.0.0.0 – all devices can connect) 
Interface IP Address – additional IP address of 
RTA-A 
Port – available network communication port (in 
case of IEC 60870-5-104 protocol, port 2404 is 
recommended) 
 

* If 2 or more different IP addresses are needed (for connecting to multiple 
networks [IEC 60870-5-101, IEC 60870-5-104]), then it is necessary to add equal 
number of ports and to define a different IP address to each port. Port 5 and 
higher all use the same physical Ethernet port. 

• Polling(v)/Answering(^) Delay – Delay between reception and the next query  

• Port Link Address – Link address of the device on uplink channels 

• IEC ASDU Address – ASDU address on uplink channels 

• Length of the ASDU Address – Length of the ASDU address in bytes on uplink 
channels. Typically 2, possible values are 1 or 2 

• IEC Object Length – Length of the IEC object address in bytes on uplink 
channels. Typically 2, possible values are 1, 2  

• Up Protocol Subversion – Number of protocol subversion on uplink channels 

• Query Timeout [ms] – Query timeout for devices on downlink channels 

• Failed Query Count for disabling contr. – Count of timeouts after which the 
error flag is raised and the query of this device temporarily suspended  

• Query Interval for Retry/Bal.mode [s] – Time period after which the suspended 
device is queried again 

• Suppress Echo – If the sent messages are echoed back by the connected 
devices then they need to be suppressed  

• Replace Event hrs – Yes/No. If Yes, events are sent to control centre with UCT 
time (the time correction value is set in Common Menu, Timing Settings) 

• Time – Determines the time tag of events 

• Control takeover DO obj.addr. – The address of an object that determines 
control takeover of that device 
*the object must be determined under a virtual device in objects table 

• Control takeover DI obj.addr. –  The address of an object that shows which 
channel has taken over the control rights 
*the object must be determined under a virtual device in objects table 
 

If some parameters in the grid area have a grey background then these are not used 
for the chosen protocol type but you are still allowed to modify them. 
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12.3.2 Devices Tab Card  
 

  
 
Parameters: 

• Device nr – Sequence number of the device 

• Objects – Number of objects in the device  

• Link address – Link address of the connected device 

• ASDU address – ASDU address of the connected device 

• ASDU address length – Length in bytes, possible values are 1 or 2  

• Object address length – Length in bytes, possible values are 1, 2 or 3 

• In use – Indicates whether the device is in use or not. If the device is not in use, 
the whole row has a grey background  

• Port – Port no. of RTA-A to which the device is connected 

• Protocol Subversion – Number of protocol subversion 

• Protocol – For information only. It is filled automatically according to the number 
of the used port.  

• Periodical Time Sync – Yes/No. If Yes, the device is synchronized with 10 
second period 

• Time Sync Forward – Yes/No. If Yes, the time synchronization which is received 
from upper channel, it is forwarded to the device 

• Control takeover valid – Yes/No. Determines if control of the device can be 
taken over (see 11.3.1 Ports Tab Card) 

• Signals blocking obj.addr.^ – The address of an object which determines 
blocking of all signals from that device. No signals are sent to control centre from 
that device 
*the object must be determined under a virtual device in objects table 

• Load XML – Load XML file with object data to the device (IEC 61850) 
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Adding devices 

By clicking on the  shortcut icon, a new device with default settings is added. It is 
also possible to add new devices with a right mouse click which makes the extended 
control menu to appear. 
 

 
 
 Add Devices dialog box appears.  

 
Set the Add Devices options:  

- Number of devices to add 
- Default settings or the device 

number from where the settings 
are derived  

- Copy Object Also 
 
Click the Add button. 
 

 
Removing Devices 
To remove a device, select Remove Devices from the extended control menu or 
click on the shortcut icon. 
 

 
 
Select the range of the removed devices and click the Remove or Remove All 

button. The selected device is also removed after the warning dialog when    is 
clicked. 
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Clearing Devices 
To clear the Device Tab Card, select Clear from the extended control menu. 
A warning window always appears before removing all devices. 
 
 

Select Yes to accept or No to cancel the removal operation of the devices. 
 
 
12.3.3 Objects Tab Card 
 

 
 

The first object of every device is used as the communication status signal of the 
device. If its value is “1” then communication with this device is broken. 
The object (first object) of communication status signal is not counted in the Objects 
row of the Devices Tab Card. 
 
Columns: 
Type – Object’s type: digital input (DI), digital output (DO), analog input (AI), counter 
(CN) 
Sub Type ^ – Object’s subtype for uplink.  
Sub Type v – Object’s subtype for downlink.  
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Subtypes of object can be selected. 

 
 

• Invert – Object’s value will be inverted 

• Fn.code – Function code on the IEC 60870-5-103 protocol 

• Info no. – Information number on the IEC 60870-5-103 protocol 

• Index – Object index on the IEC 60870-5-103 protocol. It indicates the order 
number of the object in message types 3 and 9 of analog measurements. 

• Object.Addr ν  – Object’s downlink address  

• 61850 v –  61850 address (loaded from device’s XML file) 

• Object.Addr ^  – Object’s uplink address  

• DB1 %Fs – Deadband (% of full scale). If the value has changed less than the 
deadband then it is not spontaneously transferred. 

• DB2 %Fs – This is used instead of DB if the Crit.Min and Crit.Max fields are 
used and the value falls within these limits. In case of offline (GSM) channel, 
if the change in value is bigger than deadband 2 (% of full scale) then a call to 
SCADA system is initiated.  

• Raw Min, Raw Max – Minimum and maximum raw values of analog 
measurement (before scaling). 

• Scale Min, Scale Max – Minimum and maximum scale values of analog 
measurement. 

• Forb. Ports – Uplink port to which the object’s value transfer is blocked. To 
select uplink ports, which should not be used for transferring these object 
values, double-click on the cell of the Forb. Ports column and select the 
corresponding ports from the window that has appeared. 
 

 
 

Object type Subtype ^ Subtype v  
DI – 
Digital input 

Single 
Double 

Normal 
Fallback 

DO – 
Digital output 

 Single    Direct Execute 
Double Select Execute 

AI – 
Analog input 

Normalized  
Floating point 
Step position 
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• Crit.Min %Fs / On Ev. Nr; Crit.Max %Fs / Off Ev. Nr  
Crit.Min %Fs; Crit.Max %Fs – Minimum and maximum values in % from the 
full scale of analog measurements on which RTA-A initializes communication 
(Fig. 10.5.1). If Crit. Max and Crit. Min do not have values, DB1 and DB2 are 
in use. If Crit. Max and Crit. Min have the value ‘zero’, only DeadB1 is in use. If 
the analog measurement value is between Crit. Min and Crit. Max, DB2 is in 
use. If the analog measurement value is out of limits, DB1 is in use. 
On Ev. Nr; Off Ev. Nr – Corresponding event number used in SPA-bus 

• Forb. Calling – Block object’s value transfer.  

• Ch. Nr. – Channel nr. for SPA-bus communication protocol 

• noFlags – If set to Yes, removes Invalid and Not Topical flags from object 
status. Used for objects, which statuses are not received with General Interval 
time (short circuit current, etc.) 

 
Adding Objects 

By clicking on the  button, a new device with default settings is added. 
Objects can also be added with a right click on the device tab card. After that the 
following extended control menu appears: 
 

 
 
When selecting Add Objects, the following dialog box appears: 
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Removing Objects 

To remove a device, click the    button or select Remove Devices from the 
extended control menu. The following dialog box appears: 
 

 
 
 
Hints 

• Repeated object addresses are shown on yellow background. 

• When leaving the Object Tab Card, all the objects are hidden. To see the 
objects on returning to Object Tab Card, use Expand All from the extended 
control menu that appears after a right click. 

 
 
12.3.4 Formulas Tab Card 
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Columns: 

• Type, Sub Type , Invert, Object Adr ^,  DB1 %Fs, DB2 %Fs, Crit. Min %Fs, 
Crit. Max %Fs,  Raw Min, Raw Max, Scale Min, Scale Max, Forb.Ports  - as 
in Objects Tab Card 

• DO addr.  – Number of the digital output (1…16) in the TLM GW-IO device 
controlled by the result of this formula 

• Execution count – The number of control operations executed, if no feedback 
is received from control relay. Feedback must be determined in the formula 

• Delay – Delay in seconds 

• Forb. DO – The number of DO, which control is forbidden with the result of 
this formula 

• Formula – Formula string 
 
Editing formulas 
Formulas can be created between the values of analog and/or digital objects. 
 
Referencing to object values 
To use the measurement object in the formula, insert an @ sign together with the 
object address up. 
Example: @101 points to the value of the object with an address to uplink 101. 
 
Constants  
Constants can be used in formulas. 
Example: 1.1+2.2+3 consists of 3 floating point constants 
 
Brackets  
Brackets can be used in formulas to change the priority of the operation. 
Example: sqrt(@101/2+@102); (@201+@202+@203)/3 
 
Operators 
 
Oper. Obj. type Description Sample *Priority 
+ DI/AI Addition @101+3,2 3 
- DI/AI Subtraction @101-0,49 3 
* DI/AI Multiplication @101*2 2 
/ DI/AI Division @101/2 2 
^ DI/AI Exponentiation @101^2 1 

< DI Greater than @101<0,499 4 
> DI Less than @101>0,5 4 
sqr DI/AI Square sqr(@101*10) 0 
sqrt DI/AI Square route sqr(@101*10) 0 
and DI Logical conjunction @201and@202 5 
or DI Logical disjunction @201or@202 6 

xor DI Exclusive disjunction @201xor@202 6 
not DI Logical negation not@201 0 
dbl DI Converts 2 single 

digital inputs into a 
double signal 

@202dbl@201, 
where @202 – ON 
state signal 

7 
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@201 – OFF state 
signal 

sin DI/AI  sin@301 0 
cos DI/AI  cos@301 0 
tan DI/AI  tan@301 0 
arcsin DI/AI  arcsin@301 0 
arccos DI/AI  arccos@301 0 
arctan DI/AI  arctan@301 0 

time() DI Time function time>12:00:00 and 
time<12:01:00 

 

 
* priority determines the order of operations in the formula (the highest priority is 0) 
 
Notes 

• All analog values should be scaled before making calculations; therefore, it is 
very important to fill the Raw Min, Raw Max, Scale Min, Scale Max fields with 
Normalized values that are used in calculations. 

• After editing the formula, the program automatically validates this formula and 
shows the result in the status area. If the formula is incorrect, the background 
of the edited formula is changed to pink and an error message is displayed in 
the status area. 

• By clicking on the  button, a new formula row with default settings is 
added. 

By clicking on the   button, the selected formula row is removed. 

• Formula rows can also be added, removed or cleared by using the extended 
control menu like in the Object Tab Card. It appears with a right mouse click 
on the Formula Tab Card. 

 
 

 
 
To add a Formula, select Add Formulas, to remove a Formula, select 
Remove Formula and to clear all formulas, select Clear. 

• The formulas of DI type of objects can contain AI values and floating point 
constants. If the result of the formula is greater than 0, the value of the DI 
object is “1”; if the result of the formula is less than or equal to 0, the value of 
the DI object is “0”. 

• < or > statement: if the statement is true, the value of the DI object is 1; if the 
statement is false, the value of the DI object is 0. 
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12.3.5 RTA IO Tab Card 
 

RTA IO Tab Card allows you to determine input-output object parameters of RTA-A 
and determine whether RTA-A is used as DI indicator panel or annunciator panel. 
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12.3.5.1 Configuration Parameters of Digital Inputs and Counters 
 
The following data fields are configured for each input signal: 

• Type: Digital input (DI) or counter (CN) 
 
Parameters for DI type:  

• Subtype: Single or Double and time tagging. If the Double is selected then it 
works together with the next DI forming a pair of signals. 

• Invert: Inverts the input signal 

• Obj. addr.^: Object address for the upper level device 

• Comment 

• Forb.Ports: Numbers of the ports to where this data object is not transferred 
(forbidden ports) 

• Forbid calling: Possibility to forbid the callout on upper level offline channels 
(PSTN, GSM data) 

 
Debouncing filter parameters  

• Tolerant ph.[ms]: A period of time during which state changes are ignored. 
Range: 0 … 65567 ms. Default: 5 ms. 

• Intolerant ph.[ms]: A period of time during which the state of digital input must 
remain unchanged. Range: 0 … 255 ms. Default: 5 ms. 

 
Chatter filter parameters  

• Base per.[ms]: Time interval for checking the number of changes 

• Change count: Number of allowed changes during the base period 

• Lock-out multiplier: Number of filter base periods after which the chatter filter 
will be reset if there are no more state changes 

 
Parameter for the CN type: 
• Imp.cnt.: Impulse counter for the counter (CN) type. If the value change exceeds 

it then it writes the value to output buffer (creates an event) 
 
 
12.3.5.2 Configuration Parameters of Digital Outputs 
 
The following data fields are configured for each digital output: 

• Subtype: Single or Double, “Direct Execute” or “Select and Execute” 

• Invert: Inverts the output signal 

• Obj. addr.^: Object address for the upper level device 

• Comment 

• Forb.Ports: Numbers of the ports to where this data object is not transferred 
(forbidden ports) 

• Pulse len.[ms]: Length of control pulse in milliseconds 
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12.3.5.3 Configuration Parameters of Analog Inputs 
 
The following data fields are configured for each analog input: 

• Subtype: Normalized or floating point value and time tagging 

• Meas. Range: Indicates the measurement range: +-Range, +Range, 0..20mA. It 
has to mach the ordered hardware configuration! 

• Obj. addr.^: Object address for the upper level device 

• Comment 

• DB1, %Fs: Deadband in %-s from the full scale to determine the considerable 
change. If the value change exceeds it then it writes the value to output buffer 
(creates an event) 

• DB2, %Fs: Deadband in %-s from the full scale to cause the callout on upper 
level offline channels (PSTN, GSM data) 

• Scale min.: The scaled value on the floating point value which corresponds with 
the minimum (zero) input value 

• Scale max.: The scaled value on the floating point value which corresponds with 
the maximum measured input value 

• Forb.Ports: Numbers of the ports to where this data object is not transferred 
(forbidden ports) 

• Crit.Min., %Fs: Critical minimum in %-s from the full scale. If the value falls below 
this limit then the callout is initiated on upper level offline channels (PSTN, GSM 
data) 

• Crit.Max., %Fs: Critical maximum in %-s from the full scale. If the value rises 
above this limit then the callout is initiated on upper level offline channels (PSTN, 
GSM data) 

• Forbid calling: Possibility to forbid the callout on upper level offline channels 
(PSTN, GSM data) 

• Avg per.[ms]: Averaging period for smoothening the measurement. 

• Zero zone: The zone around the zero in %-s from the full scale. If the value falls 
into this zone then it is equalized with zero. 

Remark 
Ranges of analog inputs are hardware specified. If  + - values are specified and 
range + is determined then negative values are presented as zero. Measurement 
ranges have to be determined according to the specified input values. 
 
12.3.5.4 Configuration Parameters of Analog Outputs 
 
The following data fields are configured for each analog output: 

• Range: Determines the output range: 0..20mA or 4..20mA. 

• Obj. addr.^: Object address for the upper level device 

• Comment 

• Scale min.: The scaled value on floating point value which corresponds with the 
minimum output value 

• Scale max.: The scaled values on floating point value which corresponds with the 
maximum output value 

• Forb.Ports: Numbers of the ports to where this data object is not transferred 
(forbidden ports) 
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12.3.6 Status Tab Card    
 

 
 
 
Status tab card presents the status of RTA-A general configuration parameters and 
transfer statistics. 
 
Update button is used to get information from the connected RTA-A and it is 
displayed under Device Information. 
 
 
12.4. Common Main Menu 
 
12.4.1 Analog Groups 
Interval groups are used to specify the time interval of sending analog input value to 
the remote control center when the value has changed less than the deadband. 
Interval groups can be added to analog input objects in the Configuration tool in the 
Objects tab (Analog group). 
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12.4.2 TCP/IP Settings 
Used for RTA-A to determine IP parameters.  
 

 
 
12.4.3 Timing Settings  
To determine device initialization timeouts and time zone correction. 
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12.4.4 Modem Settings  
Configure modem settings for modem callout communication mode (Port 2). 
 

 
 
12.4.5 Port Mirroring  
To determine 2 mirror groups (2 ports in each group). In case of mirrored ports, the 
data will be sent and received through both ports, but not simultaneously. If 
connection with first port fails, then connection will be established immediately using 
the second port of corresponding mirror group. 
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Notes for configuration: 
 

• If one RTA-A is connected to another as sub-RTU (one collects data from 
another), then the configuration of sub-RTU can be remotely read and written 
through the main RTU using the configuration program. 

 
 
 
12.5 Configuration of connected I/O modules remotely through the RTA-A 
 
For configuration of connected I/O modules through the RTA-A the configuration 
redirection is used. There is the menu item  “GW6/RTA-A conf redirection” in main 
menu for opening the corresponding sub window. 
 

                    
 
For activating the redirection of configuration data insert the device no. from Devices 
tab of GW6/RTA-A configuration window and press the Activate button. After that the 
redirection notice is shown in the main window until to deactivation of it. 
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13. Configuration via FTP 

 

1. Make a configuration with GWS.exe and save it as binary file  
File > Save As > Binary file (*.bin) (gwSetup.bin) 

2. Open your file browser and type in the following address:  
ftp://root@[device’s IP address]   
For example: ftp://root@10.0.0.48 

3. Open “disk” directory 
4. Copy the binary configuration file (gwSetup.bin) to the ftp directory. 
5. Wait about 1 minute (this is unnecessary if reset is sent through the 

configuration program) 
6. Perform reset operation to Telem-RTA-A device 
7. Wait until the device resumes to it’s normal operation state 
8. Configuration is complete 
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14. Communication Cables 

 
TELEM RTA-A Communication Port RJ-45 pin layout. 
 
PIN  Port 1   

RS232/Load GPS 
Port 3, 
Port4 
RS232 

Port 2  
RS232 

1   DSR 

2  CTS CTS 
3 GND GND GND 
4 RxD RXD RXD 

5 TxD TXD TXD 
6 GND GND DCD 
7  RTS RTS 
8 RX (for GPS time 

synchronization) 
 DTR 

 
 
 
 

 

RTA COM 1...4 Telem RTU 

RTA COM 1...4 

RTS

S 

CTS 

RxD 
TxD 

GND 
2 
3 
4 
5 
6 
7 

GND(port2 - DCD) 

Signal   RJ45 

RTS 

CTS 

RxD 
TxD 

GND 
2 
3 
4 
5 
6 
7 

Shield 

Pin  Signal 
RJ45 

1 

8 

RTS 
CTS 

RxD 
TxD 

GND 

2 
3 
4 
5 
6 
7 

Pin  Signal 
DB9F 

1 

8 
PC COM 

8 

1 

 
RxGPS 
GPS) 

Port 1 Port 2...4 Pin 

RTS 

CTS 

RxD 
TxD 

GND 
2 
3 
4 
5 
6 
7 

GND 

Signal   RJ45 

8 

1 

 
RxGPS 
Port 1 Port 2...4 Pin 

1 

5 

2 
3 

 RTA – Telem RTU 

 RTA – PC COM port 

RTA COM 2 

RTS 
RxD 
TxD 

CTS 

2 
3 
4 
5 
6 
7 

Pin  Signal 
DB25 

8 

1  RTA – Telephone Modem 

CTS 

RxD 
TxD 

GND 
2 
3 
4 
5 
6 
7 

DCD 

Signal  Pin 
RJ45 

8 

1 DSR 

RTS 
DTR 

DSR 
GND 
DCD 
DTR 20 Telephone Modem 

Connected: 
RJ45 - DB25 

8 - 20 
7 - 4 
6 - 8 
5 - 2 
4 - 3 
3 - 7 
2 - 5 
1 - 6 

Connected: 
RJ45 - DB9F 

5 - 2 
4 - 3 
3 - 5 

Connected: 
RJ45 - RJ45 

8 - 1 
7 - 2 
6 - 3 
5 - 4 
4 - 5 
3 - 6 
2 - 7 
1 - 8 

RTS 

RTS 

CTS 

CTS 
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15.  Firmware update 

 
Updating RTA-A firmware via ftp: 
 

• Extract the compressed firmware update file (provided by Martem AS) to your 
computer. 

• Connect to RTA-A via a SFTP client (for instance WinSCP). Default IP 
address is 192.168.0.111 if not changed by user (IP address can be seen with 
configuration software). Login as “root” (password is provided by 
Martem AS). 

• Open “disk” directory in RTA-A and copy extracted files inside “disk” directory 
on your computer to RTA-A. 

• New firmware should start automatically (you should see new firmware version 
number by updating configuration software status window). 

• Firmware update is complete. 

• If there are problems with copying files start process from beginning. 

• If new firmware doesn’t start automatically perform supply reset to the device 
(plug power supply out and then in). 

 
 

16.  Notes 

 

• If not stated otherwise on the individual pages of this document, AS Martem 
reserves the right to make modifications. 

• Although the contents of this publication have been checked for conformity 
with the hardware and software described, we cannot guarantee complete 
conformity since errors can not be excluded. 

• The information provided in this manual is checked at regular intervals and 
any corrections that might become necessary are included in the next 
releases.  

• Any suggestions for improvement are welcome.  

• The contents of this manual are subject to change without prior notice. 

• For further information Please visit Telem-RTA-A webpage at Martem Wiki. 
 
 

17. Revision History 

 
Rev 11/2012  Added I/O terminal block diagrams 


